
Welcome to TurboLaw® Time and Billing Help 
If you are new to TurboLaw® Time and Billing, you may want to review the Getting Started section. 

Sections 

Getting Started  
The TurboLaw® Time and Billing Main Window  
Entry Windows  
List Windows  
Other Windows  
Menus  
Questions  
Tasks and How-to's  

About Help 

This help file contains pictures of screens that you may see while using TurboLaw® Time and Billing. These 
pictures are representative only, and may vary from the screens that appear on your computer. 
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Tasks 
These are some of the most common tasks you will need to perform in TurboLaw® Time and Billing. To see how to do 
something, just click on the link. 

Record a received payment  
Keep track of time I've worked  
Record an expense  
Record time without billing it to my client  
Show an expense that was not billed to my client  
Add more items to a bill  
Exclude an item from a bill  
See all the work done by one particular staff member  
See all the work done for one particular client  
Import my clients from TurboLaw  
Import my clients from Microsoft Outlook  
Merge information from TurboLaw® Time and Billing on a different computer  
Backup TurboLaw® Time and Billing  
Use TurboLaw® Time and Billing on a network  
Print an item  
Delete an item  
Apply finance charges to a client  
Enter a flat-fee item  
Change whether I bill by the hour, half hour, quarter hour, or by tenths of an hour  
Charge tax  
Add a detailed description to an item on a bill  
Email a bill or statement  
Save a bill or statement as a PDF or other format  
Use the Stopwatch  
Customizing graphs and charts  
Update TurboLaw® Time and Billing  

Adding a Detailed Description to a Bill Item 
To add a detailed description to a line item from a bill, simply type the detailed description into the Details area of the item. 

If you are editing a bill, simply double-click on the line item you wish to edit, then enter the description into the details area and 
save the item. Now, when the bill is printed, the text you entered will appear in the description for that item. 

See also: 

Adding items to a bill  
Record an expense  

Adding Items to a Bill 
To add a new time or expense item to a bill, simply click the New Time/Work or New Expense buttons above the bill's line 
items. 

  

You can also add an existing work or expense item to a bill by clicking Add Existing Item. 

See also: 
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Bill window  
Add detailed description to an item on a bill  

Assessing Finance Charges 
To assess finance charges, first open the Create Statements window. Make sure the clients to whom you want to assess finance 
charges are selected. Then, click Apply Finance Charges. 

 

Finance charges are calculated automatically, based on the rate you entered for that client.  

Note that you cannot apply finance charges to a client more than once per 30 day period. Thus, if you have already applied 
finance charges to a client's account within the last 30 days, clicking Apply Finance Charges for that client again will not add 
any new finance charges to the client's account. 

See also: 

Create Statement window  

Backing Up TurboLaw® Time and Billing 
TurboLaw® Time and Billing stores all of its data in a database. By default, this database file is located in your My Documents 
folder, in a folder called TurboLaw Time and Billing. If you have a network, or if you have created other database files, your 
file may be located somewhere else. 

To back up your data, simply make a backup of this file - either by copying it to a disk (such as a CD or USB memory stick) or 
by adding it to your existing backup scheme. 

See also: 

Creating a new database  
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Changing the Billing Interval 
TurboLaw® Time and Billing allows you to set a billing interval, which is the smallest interval of time for which you will bill. 
For example, if your billing interval is hourly, then you will always bill for at least one hour, even if you did not do a whole 
hour's worth of work. Similarly, if your billing interval is set to quarter-hour intervals, then the smallest unit of time you will bill 
for is 15 minutes (0.25 hours), even if you didn't do a full 15 minutes of work. 

TurboLaw® Time and Billing allows for four different billing intervals: 

Hourly  
Half-hour  
Quarter-hour  
Tenth-hour  

By default, TurboLaw® Time and Billing uses the tenth-hour setting.  

To change the billing interval, click the Tools menu and choose Settings. 

 

Simply select the billing interval you would like to use and then click OK. 

See also: 

Recording Billable Time  

Charging Tax 
TurboLaw® Time and Billing allows you to apply a tax to time for which you bill.  

To charge tax, simply click This Item is Taxable and then type in the percentage tax that you want to charge. 
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TurboLaw® Time and Billing will automatically calculate the amount based on the percentage that you enter and add it to the 
total. 

See also: 

Recording Billable Time  

Customizing Graphs and Charts 
To customize the way TurboLaw® Time and Billing displays a chart, click the Chart Wizard button. 

You can navigate through the chart wizard by either using the Next and Previous buttons at the bottom of the window, or by 
using the links in the navigation bar on the left. 

The first four pages of the wizard apply to the construction of the chart - the remaining pages deal with the presentation of the 
data. 

Chart Type 
The first screen will let you choose the type of chart, such as bar, pie, line, etc.  

Note that some types of graphs cannot be displayed as some types of charts. For example, graphs with more than one data series 
(e.g., billed and unbilled time) cannot be displayed as a pie chart.

Page 4 of 30Tasks

8/20/2008file://C:\Documents and Settings\Keith\Local Settings\Temp\~hh3ACE.htm



 

Appearance 
This screen will allow you to choose a color scheme for the graph. You can choose a color palette from the Palette drop-down 
box, and then a specific style from that palette using the Style drop-down box. A preview of your graph will be displayed.
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Series 
This screen will allow you to customize the data series that is used in the graph. You can choose whether the data are sorted 
(and how they are sorted), as well as whether they are numerical or qualitative data.
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Data 
This screen allows you to directly modify the data used in the graph. You can change the labels of the items if desired, or even 
use this screen to enter your own custom data - effectively turning TurboLaw® Time and Billing's graphs into your own custom 
graphing tool. 
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Diagram 
This screen allows you to customize the diagram portion of the graph. The "diagram" is the graphical part of the graph - the 
"chart" portion, in other words.  

You can: 

Rotate the diagram  
Add padding to any of the sides  
Adjust the background  
Add a drop-shadow  
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Axes 
This screen allows you to customize the X and Y axes (if applicable) of the graph.
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Series Views 
This screen allows you to customize the way the series (the colored bars in the picture below) are viewed. The options that 
appear here will vary depending on what type of graph you have selected.
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Point Labels 
This screen allows you to customize the "point labels" that appear above each item in the graph. These items usually show the 
value of that portion of the chart (bar, pie slice, etc.). You can turn these labels off or customize their appearance by modifying 
their position, their font size, color, and antialiasing properties, as well as apply a drop-shadow. 

In the picture below, the point labels are outlined in red and are just above each bar in the chart.
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Chart Titles 
This screen allows you to customize the titles displayed in the graph. By default, most graphs have only one title, usually at the 
top. However, you can add additional titles and position them on any of the four sides of the graph. You can add more than one 
title to each side - for example, you could add a second title to the top of the graph shown below, and adjust the text to be 
somewhat smaller, so that it appears as a "sub-title." Or, if you prefer, you can remove all of the titles from the graph and just 
display the chart itself. 
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Legend 
This screen allows you to customize the legend for the graph. You can adjust its placement on the report as well as the spacing, 
font, size, and drop-shadow. 
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The Finished Graph 
Below is a sample of a customized graph, using the exact same data shown in the pictures above. It has been rotated, additional 
chart titles have been added, the point labels have been moved to the "inside" position, the series views have been set to "color 
each bar," the background of the chart has been customized, and the X axis has been set to stagger the labels so they are easier to 
read. 
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You can make whatever changes you like to a graph - TurboLaw® Time and Billing will revert back to the default settings the 
next time you open the graph window, so you don't have to be afraid of making changes.  

See also: 

Graphs and Charts window  

Deleting an Item 
You can delete an item from TurboLaw® Time and Billing in several different ways.  

The Delete Key 
When an item is selected in a list, simply press the delete key on your keyboard to delete the item. If multiple items are selected, 
they will all be deleted. 

The Delete Button 
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The delete button is found on the toolbar of most items. Simply click this button to delete the item.  

 

On all list windows, you will find a different delete button - however this button works exactly the same. Simply click it to delete 
the selected item(s). 

The Delete Link 

 

 

 

An alternative method can sometimes be found in the main navigation bar. For each of the items that can be displayed in the 
main list (clients, staff, and bills), a delete link will appear in the navigation bar. Simply click this link to delete the selected item
(s). 

Delete Confirmation 
Whenever you delete an item, TurboLaw® Time and Billing will prompt you to confirm your action. Deleting an item from 
TurboLaw® Time and Billing's database is a permanent action, and cannot be un-done. (There is no "Recycle Bin" in 
TurboLaw® Time and Billing.) 

 

If you are sure you want to delete the item, click Delete. If you don't want to delete the item, click Don't Delete. If you were 
deleting items as part of a larger action, and want to stop the action as well, click Cancel. 

See also: 

Backing up TurboLaw® Time and Billing  

Emailing Items 
TurboLaw® Time and Billing allows you to email items, such as bills and statements, directly to your clients. In fact, anything 
you can "Print Preview" in TurboLaw® Time and Billing can be emailed.
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Simply click the Email as button to email the previewed document. By default the document will be sent as PDF; however you 
can change this by clicking the drop-down arrow on the Email as button. 

TurboLaw® Time and Billing will prompt you to save the item before opening your default email program with the item 
attached. 

Emailing with Webmail 
If you use a web-based email service, such as Google Mail, Yahoo! Mail, or MSN Hotmail, then you cannot use the Email as 
feature of TurboLaw® Time and Billing. This is a limitation of all web-based email services, not just TurboLaw® Time and 
Billing.  

To send a file via webmail, use the Save as button instead to save your document as a file (PDF or other format) first. Then, use 
the normal method for attaching files to an email within your particular web-based email. 

See also: 

Print Preview window  

Entering a Flat Fee Item 
Entering a flat-fee item is only a little different from entering a normal work item. 

Simply check the box which says "This is a flat fee item." The total amount displayed at the bottom right corner will now 
become active and you can directly type in how much this flat-fee item is for. 

Page 17 of 30Tasks

8/20/2008file://C:\Documents and Settings\Keith\Local Settings\Temp\~hh3ACE.htm



 

If you need it, you can click the drop-down arrow to open a mini-calculator. 

 

See also: 

Time window  
Recording billable time  

Excluding Items from a Bill 
To exclude an item from a bill, simply un-check the item. 

 

When you save the bill, any un-checked items will not be saved as part of the bill.  

If you need to add an item back to the bill, simply click Add Existing Item. 

 

See also: 

Creating your first bill  
Bill window  

Importing Clients from Microsoft Outlook 
To import multiple clients' information from Microsoft Outlook, click the File menu and choose Import and then Import 
Clients from Outlook.  
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After a moment, a screen will appear with all the available contacts from your Outlook address book. Simply select the ones you 
wish to import and click Import. 

The imported clients will show up in your list of clients in TurboLaw® Time and Billing. 

To import a client's information while you are on the Enter Client screen, simply click the Import button and choose Client 
from Outlook. 

 

See also: 

Import clients from TurboLaw  
Merge data from TurboLaw® Time and Billing  

Importing Clients from TurboLaw 
To import multiple clients' information from TurboLaw® Document Software, click the File menu and choose Import and then 
Import Clients from TurboLaw.  

 

After a moment, a screen will appear with all the available clients from your TurboLaw® database. Simply select the ones you 
wish to import and click Import. 

The imported clients will show up in your list of clients in TurboLaw® Time and Billing.
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To import a client's information while you are on the Enter Client screen, simply click the Import button and choose Client 
from TurboLaw. 

 

See also: 

Import clients from Microsoft Outlook  
Merge data from TurboLaw® Time and Billing  

Keeping Track of Time 
To keep track of time accurately, use the Stopwatch in TurboLaw® Time and Billing. If TurboLaw® Time and Billing is open, 
you can click the Stopwatch link from the navigation bar. Or, if TurboLaw® Time and Billing is hidden, you can right-click the 
notification icon and start the stopwatch from the shortcut menu. 

 

Once the stopwatch is open, just click Start to begin timing an activity. 

 

You can click Pause to pause the stopwatch at any time. Simply click Resume when you want to resume timing your activity. 

You can open as many stopwatches as you need - whenever you open a new stopwatch, TurboLaw® Time and Billing will pause 
the previous stopwatch for you.  

Once your activity is complete, click Save to save the time into TurboLaw® Time and Billing. 

See also: 
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Using the stopwatch  
Stopwatch window  

  

Making Clients Inactive 
When you are no longer doing work for a client, you may wish to mark him or her as "inactive" so that they do not clutter up 
your view of clients. To do this, simply edit the client and un-check the box which says "This client is an Active Client." Then, 
click Save & Close to save your changes. 

 

The inactive client will not show up in your list of clients (by default), although you can have TurboLaw® Time and Billing 
show inactive clients if you wish. 

See also: 

Client window  
Entering Clients  

Merging Data from TurboLaw® Time and Billing  
TurboLaw® Time and Billing stores its information in a single data file. If you have TurboLaw® Time and Billing on two or 
more computers, and have entered information into TurboLaw® Time and Billing on those computers, and now wish to 
consolidate and store all your data in one place (in one file - perhaps on a server), you can merge the data files together. 

To do this, click the File menu and choose Import and then Merge data from TurboLaw Time and Billing. 
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You will be prompted to locate the data file you wish to merge with. Simply select the data file and TurboLaw® Time and 
Billing will merge the information from that data file into the currently open one.  

The merging process usually only takes a few moments, although it will take longer the more clients you are merging. 

After merging, you may wish to double-check the Billing and Expense categories, as you may end up with duplicate category 
names. You may also wish to review the staff list, in case there are duplicates there as well. TurboLaw® Time and Billing does 
not detect duplicates when it merges information. 

See also: 

Importing Clients from TurboLaw  
Importing Clients from Microsoft Outlook  

Printing 
To print in TurboLaw® Time and Billing, simply click the Print button or choose the File menu and then select Print.  

 

The print button is available in most windows - for example, bills, statements, clients, staff members, time entries, expense 
entries, and so forth. It generally will print what you see on the screen - if you are viewing just one client, then just that client 
will be printed. If you are viewing a list of items, then that entire list will be printed. 

The print button usually acts as a "drop down" button - this means that when you click the button, a drop-down menu will 
appear. The typical entries on this drop down menu are Print, Print Preview, and Page Setup. 

Print 
This causes TurboLaw® Time and Billing to print the item displayed. You will be prompted to select a printer before the item 
will be printed, however. 
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Print Preview 
This causes TurboLaw® Time and Billing to show you a preview of what your item will look like when it is printed. The print 
preview will open in a separate window. 

Page Setup 
This causes TurboLaw® Time and Billing to show you a window where you can select various options for how the page will be 
laid out, such as its orientation and size. 

 

See also: 

Print Preview window  
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Saving to PDF  

Recording a Payment 
To record a payment, click Receive Payment from either the workflow home screen, the client navigation bar, or the edit client 
window. 

 

Simply type in the amount received, select the client for whom the payment was made, and the date you received the payment. If 
you need to, you can click the drop-down button to display a mini-calculator. 

You can also enter a short note about the payment for your records. 

If this payment pays off a bill in full, you can mark the bill as "paid" or "closed" so that it won't be counted anymore. The list of 
open bills is shown at the bottom of the window so you can check off any bills that are now paid/closed with this payment. 

See also: 

Receive Payment window  

Recording an Expense 
To record an expense, click either Enter Time/Expense from the workflow home screen, or click the Time/Work button on the 
edit client window, or click New Expense from the client navigation bar.
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Once the expense window is open, simply enter the amount of the expense, what the expense was for, whether the expense was 
billable or not (by checking the box), what client the expense will be billed to, the date of the expense, and the staff member 
associated with the expense (if there is one). 

You can also enter a more detailed description of the expense. 

See also: 

Expense window  

Recording Non-Billable Time 
To record non-billable time, simply enter the time as you would normally, but check the box which says "This time was not 
billable." 

The amount to be billed will automatically be set to zero, but you can still save the time. It will show up on a bill with an amount 
of zero ($0.00). In this way, you can let your client know what work was performed for which he or she was not billed. 

See also: 

Time window  
Recording billable time  

Saving to PDF 
Anything that can be printed in TurboLaw® Time and Billing can be saved to as a PDF file. Simply choose Print Preview to 
open the print preview window, and click the Save as PDF button.

Page 25 of 30Tasks

8/20/2008file://C:\Documents and Settings\Keith\Local Settings\Temp\~hh3ACE.htm



 

You do not need any other software installed to save to PDF from within TurboLaw® Time and Billing. 

You can also save to PDF from the Export section of the print preview window. 

 

PDF is the default format for saving in TurboLaw® Time and Billing, however other formats are supported. The available 
formats you can save to will depend on the type of item you are trying to save. 

 

See also: 

Print Preview window  

Showing all Work Performed by one Staff Member 
To display all the work and expense items linked to one particular staff member, first select the desired staff member from the 
Staff list in the main window of TurboLaw® Time and Billing. Then, click View Work from the staff navigation bar.
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A list of all the work and expense items that were linked to this staff member will be displayed. 

See also: 

Time and Expenses window  
Showing all work for one Client  

Showing all Work Performed for a Client 
To display all work and expenses linked to a particular client, first select the desired client from the Client's list in the main 
window of TurboLaw® Time and Billing. Then click View Work from the client's navigation bar. 

 

A list of all work and expense items linked to that client will be displayed. 

See also: 

Time and Expenses window  
Showing all work doine for a Staff member  

Show Unbilled Expense 
To show an unbilled expense, simply check the box which says "This expense was not billable" when entering the expense. 

The expense's amount will automatically be set to zero, but you can continue to save the expense. It will show up on the client's 
bill with an amount of zero ($0.00), so that you can show your client what expenses you incurred but which were not billed. 

See also: 

Expense Window  

Using the Stopwatch 
The stopwatch acts just like a normal stopwatch. 

Opening the Stopwatch 
If TurboLaw® Time and Billing is open, you can click the Stopwatch link from the navigation bar. Or, if TurboLaw® Time and 
Billing is hidden, you can right-click the notification icon and start the stopwatch from the shortcut menu. 
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Starting the Stopwatch 
Once the stopwatch is open, just click Start to begin timing an activity. 

 

Pausing the Stopwatch 
You can click Pause to pause the stopwatch at any time. Simply click Resume when you want to resume timing your activity. 

Resetting the Stopwatch 
You can click Reset to reset the stopwatch's time back to zero (00:00:00) and begin recording time again from zero. 

Opening Multiple Stopwatches 
You can open as many stopwatches as you need - whenever you open a new stopwatch, TurboLaw® Time and Billing will pause 
the previous stopwatch for you.  

Saving your Time 
Once your activity is complete, click Save to save the time into TurboLaw® Time and Billing. 

See also: 

Stopwatch window  
Keeping track of time  

auses TurboLaw® Time and Billing to show you a window where you can select various options for how the page will be laid 
out, such as its orientation and size.
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See also: 

Print Preview window  
Saving to PDF  

Updating 
If your computer has an active Internet connection, TurboLaw® Time and Billing will periodically check to see if there is a new 
version of the program available. If one is found, you will be notified and will have the option to install the update now, or install 
it later. 

 

Updating Immediately 
When the update notification appears, simply click on the balloon message itself. TurboLaw® Time and Billing will close, and 
the update will begin. Once the update is complete, TurboLaw® Time and Billing will re-open. 

Updating Later 
If you do not want to update immediately when the notification is shown to you, you can simply ignore it. When you are ready to 
install the update, simply right-click the notification icon and choose Install Update.  

Checking for Updates 
In most cases, you do not need to do anything to check for updates to TurboLaw® Time and Billing, as the program will check 
for updates periodically on its own. However, if you do need to force TurboLaw® Time and Billing to check for updates 
immediately, you can do so by clicking the Help menu and choosing Check for Updates.
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See also: 

Help menu  

Using TurboLaw® Time and Billing on a Network  
Because TurboLaw® Time and Billing stores data in a database, multiple users can open this database at once using TurboLaw® 
Time and Billing, and enter items into the database at the same time. 

TurboLaw® Time and Billing uses a file-based database, which means that you can open the database the same way you would 
open any other file on your computer. 

To use TurboLaw® Time and Billing on a network, simply have each user on your network open the same database. You can 
choose which database to open by clicking the File menu and choosing Open. 

You can create a new empty database on the network by clicking the File menu and choosing New. If you'd prefer to start with 
the database you are currently using, you can save your current database onto the network (or any other location) by clicking the 
File menu and choosing Save As.  

It is recommended that you save your TurboLaw® Time and Billing database to a server (if available); however this is not 
required as long as the database file can be opened by each user. 

Notes on Networking 
TurboLaw® Time and Billing must always be able to open the database file in order to save items to it. If you are disconnected 
from the network, or cannot open the database file for some other reason (e.g., the file was moved, renamed, or taken off-line), 
then you will not be able to work on the data in that database. 

If you are not sure what database TurboLaw® Time and Billing currently has open, simply click the Help menu and choose 
About. TurboLaw® Time and Billing will display the full name of the currently open database (along with other information 
about the program). 

Making a file available for all users to open on a network can be a simple task. However, there are situations where it can 
become quite complex. Things such as user permissions and read/write access can cause subtle but frustrating errors to appear, 
especially if you are on a larger corporate network. If you are in doubt, please consult your IT department or a qualified network 
technician to help you put your TurboLaw® Time and Billing database file in a location where all users can access it. 

See also: 

File menu  
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Questions 
These are some common questions that may come up while using TurboLaw® Time and Billing. 

What is the difference between a Time or Expense code?  
What is the difference between a Time or Expense entry?  
What is the difference between a bill and a statement?  
What is the Customer Experience Improvement Program?  

What is the Difference Between a Time Entry 
and an Expense Entry? 
A time entry is work that you've done for a client for which you are billing that client. In many cases 
you will record the time you spent doing the work, but you could also enter it as a flat fee item. 

An expense entry is an expense you've incurred that you will pass on to your client. Expense entries 
don't have a time component - they are just the dollar amount of the expense. 

See also: 

Enter Time window  
Recording billable time  
Enter Expense window  

What is the Difference Between a Time Code and 
an Expense Code? 
A time code is a category for time entries. An Expense code is a category for an expense. 

TurboLaw® Time and Billing keeps separate categories for each item, so that you don't end up with a 
huge category list. 

See also: 

Time category  
Expense category  

What is the difference between a bill and a 
statement? 
In TurboLaw Time and Billing, a bill (also sometimes called an invoice) is just what you'd think it is: an 
itemized list of work done for (or expenses incurred on behalf of) the client, and how much is owed to 
you for it. For example, a bill might have the following items on it:
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Spent 3 hours in court: $750.00  
Travel expenses to meet with client: $75.00  
On-site meeting: $250.00  
TOTAL DUE: $1,075.00  

This is like a bill or invoice that you might get when you purchase something. TurboLaw Time and 
Billing calls it a "bill" because you "bill" for your services, while you get an "invoice" for goods – but in 
practice the two terms are generally interchangeable. 

A bill doesn’t say anything about money that might have already been paid – it simply lists the work or 
expenses you've done or incurred and how much they total. 

On the other hand, a statement in TurboLaw Time and Billing is a "statement" of the status of the 
client's account at a particular point in time. Each line item on a statement represents either a bill or a 
payment. As such, it doesn't offer as much detail as a bill; but it does show payments made toward the 
account. Statements are often sent out on a regular basis (e.g., monthly – like your credit card statement) 
to show your clients where they stand (and if they still owe you money). For example, a statement might 
have the following items on it: 

Balance forward: $85.67  
Bill #123: $290.00  
Payment #82: $50.00  
TOTAL BALANCE: $325.67  

This shows that the client had a balance due of $85.67 from before the period of this statement (if you 
send out statements monthly, your statement period is usually "the last 30 days") and that in that time, a 
bill for $290.00 was produced, but the client sent in a payment of $50.00, resulting in a final balance due 
of $325.67. 

In general, you'd use a bill to show the details of the work and expenses for which you are billing. You'd 
use a statement to give an overall indication of the client's account, including any 
payments/retainers/etc. You don't have to limit yourself to sending statements only at the end of the 
month – if you want to give your clients frequent overviews of their accounts you can print a bill and a 
statement for a client and send them out together.  

Ultimately, how you use bills and statements is up to you – use them in whatever way works best for the 
way you do business and to enhance cash flow. 

See also: 

Bill Window  
Statments Window  

   

What is the Customer Experience Improvement 
Program? 
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The Customer Experience Improvement Program is an optional program where anonymous information 
on how you use TurboLaw® Time and Billing is collected and transmitted to us periodically, without 
interrupting you. This information helps us identify which features to improve. 

Other Questions 

How does the program work? Will I have to answer questions? Will I be interrupted? 

The program silently records statistical information on what options, features, and buttons you press 
most often in the program. It then sends this anonymous statistical data back to our servers and then 
clears the data that was sent to us from your computer. 

It will never interrupt you or ask you any questions after you make your initial choice to either enroll or 
not enroll in the program. 

Will I be contacted? 

No. You will never be contacted because of or in relation to this program. 

What data is being collected? 

Only anonymous, statistical information on how you use the program is collected - what buttons you 
press most often, for example. A timestamp is also included so that we can chart usage over time, as is a 
random, unique number that is used simply to identify the data in our database. 

How is the program "anonymous?" How is my privacy assured? 

We take our customers' privacy very seriously. No personally-identifiable information about you, 
your computer, your license, or your software is ever transmitted. The program generates random, 
unique numbers to identify the data for our database, but these numbers cannot be traced back to you or 
your computer. 

Is any of my client data transmitted? 

No - your client data is never transmitted.  

What if I change my mind? 

The Updates tab of the Settings window allows you to change your enrollment in the program. 

What is the purpose of the program? 

The purpose of the Customer Experience Improvement Program is to allow us to see exactly how people 
are using the program - what buttons they click on most often, which features they use frequently, etc. A 
statistical analysis of this data is very helpful in identifying which features to improve, based on which 
features people use most often. 
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Other Windows 
This section lists some of the other windows in TurboLaw® Time and Billing that do not fall into any of the other categories. 

Account History  
Bill window  
Create Statement  
Getting Started Window  
Import Clients  
Main Window  
Notification Icon  
Print Preview  
Graphs and Charts  
Search window  
Settings window  
Stopwatch  

See also: 

List windows  
Entry windows  

Account History 
The account history window displays a detailed history of a client's bills, expenses, and payments. 

 

There are four main categories of items that are displayed: 

Unbilled items  
Unpaid (open) bills  
Paid (closed) bills  
Payments  

Under each of these four categories will be all the items from that category for this client. You can expand or collapse any particular category by double-clicking 
on the category name, or by clicking the plus (+) or minus (-) sign (as appropriate) next to the category name. 

You can double-click on any item to open that item and view more information about it, edit it, or even delete it, if desired. 

See also: 

Enter time window  
Enter expense window  
Bill window  
Payment window  

Bill Window 
The bill window allows you to set the basic options for a bill, such as the date, what items will appear on the bill, and whether the bill has been paid or not.
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Bill To 
This allows you to select the client you are going to bill. When you select a client, all the time and expenses for that client that haven't yet appeared on a bill are 
automatically selected. 

If you need to make a last-minute correction to the address before you print a bill, you can do so here. Note that your changes will not be saved - they are one-
time only. 

Bill Number 
This is the number of the bill. TurboLaw® Time and Billing will fill this in for you automatically - you cannot change it. 

Bill Date 
This is the date of the bill. You can change it if you want to. 

Bill Status 
This allows you to mark the bill as paid or not paid.  

Bill For 
This allows you to select the matter you are billing the client for (if any). This drop-down box will only be available after you have selected a client. 

If you select a matter, TurboLaw Time and Billing will automatically populate the bill with only those time/expense items that are associated with the same 
matter. If this isn't what you want, you can click the Add Existing Item button to add time/expense items from other matters to this bill. 

If you change your mind and don't want to file this bill under a particular matter, click the "X" button to clear the selection. The bill will be filed under the 
client's name, but not under any particular matter. 

Unbilled Time and Expenses for this Client 
This section displays the contents of the bill. Each item that has a checkmark next to it will appear on the finished bill. Unchecked items are not included.  

You can double-click on any item to edit it. 

If you need to add a new time/work entry to appear on the bill, you can do so by clicking the New Time/Work button. Likewise, if you need to add a new 
expense entry to appear on the bill, just click New Expense. If you have previously entered a time or expense item and want it to appear on this bill, you can 
click Add Existing Item to add it to the bill. 

If you want to remove an item from the bill, simply un-check the item. When you save the bill, the un-checked items are removed from the bill.
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Extra Toolbar Buttons 
In addition to the standard Save & Close, Save & New, Print, Delete, Back and Next buttons, the bill window includes a Void button and a Template button. 

Void 

The void button allows you to "void" the bill - effectively removing it from the client's account by setting the total to zero ($0.00). However, the bill itself - as 
well as everything on the bill - remains in the system, so that there is a record of it.  

Template 

The style button allows you to choose the template that will be used when the bill is printed. 

See also: 

Creating your first bill  
Choose Template window  
What is the Difference between a Bill and a Statement?  

Create Statements 
The create statement window allows you to select the various options for creating statements, such as which clients to create statements for, as well as what dates 
the statement(s) will cover. 

 

Once you have set your options, click Print to print your statements or see a print preview. You can also open the template designer by clicking Print and then 
selecting Designer. 

Selecting Clients 
The create statements window shows you a list of clients, and their balance. Statements will be created for those clients who are checked.  

By default, all clients with open balances are selected. You can use the Unselect All button to unselect all of the displayed clients. Once clicked, this button 
changes to Select All, which you can then click to re-select all of the displayed clients. 

Apply Finance Charges 
Clicking this button will calculate any applicable finance charges for the selected clients and add that amount to their balances. The finance charge will appear 
on the client's statement as a line item marked "Finance Charge." 

Removing a Finance Charge 

If you want to remove a finance charge that you've applied to a client, you must exit the create statements window. Finance charges appear in TurboLaw® Time 
and Billing as a bill with a single line item. To remove the finance charge, simply void (or delete) the bill on which the finance charge appears. Finance charge 
bills are marked as "finance charge," so they are easy to pick out from the list of bills.
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Show 
You can select whether to display only those clients with open balances (the default), or all clients.  

Statement Date 
This is the "effective date" for the statements, and will be printed on the statements themselves. 

By default, the statement date is set to the current date. 

Statement Period Start/End 
This is the range of dates that will determine which items are included on the statement. Only bills and payments from within the statement period will be 
included as line items on the statement - anything prior to the statement period will appear only as a "Balance Forward." Anything after the statement period will 
be ignored. 

By default, the statement period is set to the previous 30 days. 

Template 
This lets you choose the template for your statements. 

See also: 

Bill window  
Using the navigation bar  
What is the Difference between a Bill and a Statement?  

Getting Started Window 
The first time you start TurboLaw® Time and Billing, the first thing you will see is the Getting Started window. This screen will appear each time you start 
TurboLaw® Time and Billing (unless you switch it off). 

  

From this window, you can enter staff, enter your address, and enter clients.  

If you do not wish to see the Getting Started window each time you start TurboLaw® Time and Billing, simply un-check Show this screen on startup. 

See also: 

Getting Started  
Entering staff  
Settings  
 
Entering Clients  

Import Clients 
The import clients window allows you to import either a single client or multiple clients into TurboLaw® Time and Billing. 
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You can access the import window either from the File menu or from the client activity toolbar. 

 

 

Importing Multiple Clients 
If you choose to import clients from the File menu, you will be able to select multiple clients to import all at once. Simply select the clients you wish to import, 
then click Import. 

Importing a Single Client 
If you choose to import clients from the client activity toolbar, then you will be able to import only one client. This is because the client you import is entered 
onto the client window itself - and the client window can only show one client at a time. 

See also: 

Importing clients from Outlook  
Importing clients from TurboLaw  
Merging data from TurboLaw® Time and Billing  

Main Window 
The main window of TurboLaw® Time and Billing is what you see when you start the program. It contains the navigation bar on the left, and either the home 
screen or the main list on the right. 

At the top of the main window are the File, View, Tools and Help menus - as well as the Search box (in the upper right corner). 

At the bottom of the main window is the status bar, which displays different information, depending on what it shown (or selected) in the main window itself. It 
will also display a progress bar, if the program is performing a lengthy operation. 

Main Window - Home Screen 
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Main Window - Clients List 

 

Notice how the navigation bar's contents change based on what is displayed in the main list.
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Main Window - Bills List 

 

You can see from the picture above how bills are grouped together, as well as how finance charges are displayed. 

Main Window - Staff List 
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See also: 

Getting Started window  
Using the navigation bar  

Notification Icon (Tray Icon) 
In order to keep TurboLaw® Time and Billing's options close at hand, TurboLaw® Time and Billing places an icon in the notification area (sometimes called 
the system tray) of your computer's taskbar. (The taskbar is typically located in the lower right-hand corner of your computer's screen.) This icon can be used to 
access some of the common functions of TurboLaw® Time and Billing. 

 

This menu is accessed by right-clicking on the notification icon.  

Additionally, when you close the TurboLaw® Time and Billing window by clicking the close button (  or ), the program will only be hidden - not closed 
completely - and can be restored at any time by double-clicking the notification icon, or selecting the Show TurboLaw Time and Billing option from the 
shortcut menu. 

Show TurboLaw Time and Billing 

This option will display the TurboLaw® Time and Billing window and bring it to the front of your screen. You can also just double-click the notification icon. 

Add Client 

This option will open the Add Client window. 
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Enter Time 

This option will open the Enter Time window. 

Enter Expense 

This option will open the Enter Expense window. 

Search 

This option will open the Search window. 

Show Stopwatch 

This option will open the stopwatch window. You can open multiple stopwatches, if needed, by selecting this option multiple times. 

Exit 

This option will exit TurboLaw® Time and Billing completely. 

See also: 

Stopwatch window  
Recording billable time  
Entering clients  

Print Preview 
The print preview window displays a preview of what will be sent to the printer.  

 

The print preview window contains many different groups of buttons that allow you to customize your output before it is printed. 
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Application Button 
The application button functions like the File menu in other programs. It gives you access to the print commands, as well as the option to close the window. 

Quick-Access Toolbar 
The quick-access toolbar is a small toolbar where you can place various buttons that you use frequently. It can be customized by clicking the small downward-
pointing arrow just to the right of the toolbar itself. 

By default, the quick-access toolbar contains the Print button, the Save to PDF button and the Email as PDF button. 

Print Preview Tab 
The print preview tab contains all of the other options for customizing your print job. From left to right, these sections are: 

Print 

The print section contains the two print buttons. 

Print 

This is the "normal" print button. Clicking this button will display a window where you can choose the printer you want to use when you print. 

Quick Print 

The quick print button does not display any windows - it simply prints your document to the default (or currently selected) printer, without asking you anything. 
This is a "one-click" print button. 

Page Setup 

The page setup section contains buttons relating to the size, layout, and margins of the page. If you would like to see a single window with all of these options, 
simply click the "More Page Setup options" tag in the lower right corner of this section. 

Header/Footer 

Depending on what you are printing, this option may or may not be available. If it is available, you can click this option to set up headers and footers for the 
document. 

Headers and footers can contain text that is left aligned, right aligned, or centered. You can adjust the font face, font size, and other options for the text that 
appears in the header or footer. 

There are several "automatic" items that can be placed in the header and footer - items such as the page number (which calculates automatically), the current 
date, or even your user name on your computer.  

Scale 

This option allows you to set the scaling options for the page. By default, pages are printed at 100% scaling - this is "normal" size. You can adjust this size if you 
wish. 

Margins 

This option allows you to set the margins for the page.  

Orientation 

This option allows you to set the orientation of the page, either landscape or portrait. 
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Size 

This option allows you to set the size of the paper that will be used when the document is printed. 

Navigation 

This section contains options for navigating through the document - moving from page to page, and finding text in the document. 

Zoom 

This section contains options for zooming in on the document. These options affect only the way the document is displayed on your screen - they do not affect 
the printed document itself. 

Page Background 

This section contains options for customizing the background of the page itself. 

Page Color 

This option allows you to set a color for the background of the page. Be cautious when using this option to print to paper, as it may use a large amount of ink or 
toner.  

If you are going to save your document as a PDF or other file format, rather than printing it to paper, you may find this option useful to increase the impact of 
your document. 

Watermark 

This option allows you to set either text or an image as a "watermark," or faded background, on the page. For example, you could have the text "Confidential" 
appear faded in the background if you were printing something that you wanted to remain confidential. Alternatively, you could use your corporate or firm logo, 
faded in the background, to add extra impact to your document. 

Export 

This section contains the options for exporting your document in the various formats that TurboLaw® Time and Billing supports. The default export format in 
most cases is the Adobe Portable Document Format (PDF). This format can be viewed by almost any type of computer or device, and is the most commonly 
used format for sending documents through the Internet. However, other formats are available, as shown below. 

 

Save To... 

TurboLaw® Time and Billing allows you to save your document to many different formats, such as: 

Adobe Portable Document Format (PDF)  
Web page (HTML)  
Plain text (TXT)  
Comma-separated values text (CSV)  
Single file web page (MHT)  
Microsoft Excel workbook (XLS)  
Rich Text Format (RTF)  
Image File (BMP, GIF, JPEG, PNG, TIFF, EMF, WMF)  

Note: Depending on the type of document you are printing, all of these formats may not be available. 

Email To... 
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TurboLaw® Time and Billing also allows you to email your document in one of the formats specified above. Clicking this button will first prompt you to save 
the document, and then it will open your default email program. 

Note: If you use web-based email, such as Google Mail, Yahoo! Mail, or MSN Hotmail, you will not be able to use this feature. You must save the document in 
the desired format and attach it to your email manually. This is a restriction of all web-based email, not just TurboLaw® Time and Billing. 

Close Print Preview 

This button will close the print preview window. 

See also: 

How to Save to PDF  

Graphs and Charts 
The Graphs and Charts window allows you to choose from several different types of graphs (charts) and the various options for displaying those graphs.  

 

On the left is the report window's options bar, similar to the navigation bar in the main window of TurboLaw® Time and Billing. It allows you to choose the 
type of graph that will be displayed, as well as options for what data will be included in the graph. 

Graph Data 
These are the different data that you can display in your graph. Some of the data is in hours, other data is in dollars. To display the data in the graph, simply 
check the box next to the data you would like to see. 

In general, you would not display dollars and hours on the same graph, however, you can use the Chart Wizard to set up separate axes for the graph and 
produce various graphs of your own. 

Dates 
This section allows you to select whether the graph should be limited to a specific period of time, or whether it should include all available data. 

Graph by Client/Staff 
This section allows you to select how the data will be grouped. It can be grouped by Staff Member, Client, or by date interval (monthly, quarterly, yearly). 

Save to PDF 
This button allows you to save the graph as shown to a PDF file.
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Save as Image 
This button allows you to save the graph as shown as one of several different image format files, such as BMP, JPG, or PNG. 

Copy to Clipboard 
This button allows you to copy an image of the graph as shown into the Windows clipboard, which you can then "paste" into another program. 

Chart Wizard 
This button opens the Chart Wizard window, which allows you to customize your graph in great detail. 

 

You can choose what type of graph (chart) you want to use, as well as customize all aspects of its appearance - the title, the fonts, colors, axes, legends, and so 
on. 

See also: 

Customizing Graphs and Charts  

Search Window 
The search window displays the results of your search, as well as allowing you to begin a new search. 

Simply type what you would like to search for in the search box and click Search. The results will be displayed. 

You can double-click on any item to display more details about that item or to edit it (if it can be edited).
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See also: 

Main window  

Settings 
The settings window allows you to choose several different options for how TurboLaw® Time and Billing will work. The settings window is divided into tabs, 
each of which contains options relating to a different section of the program. 

Billing 

 

Minimum Billing Interval 

You can choose what increment (if any) that you bill by. The default setting is tenths of an hour, but you can select any other option, including entering your 
own custom billing increment. Whatever option you select, TurboLaw® Time and Billing will round all time entries to match your setting. 

If you choose to bill for "exact time" only, TurboLaw® Time and Billing will not round your time at all - your clients will be billed for exactly the amount of 
time you enter, down to the second. 

Bill Group Labels 

These are the labels that TurboLaw® Time and Billing will use when it groups your items on a bill. The default labels are "work" and "expenses," which are the 
labels used by TurboLaw® Time and Billing. You can change the labels if you wish - for example, you might wish to have your bills say "Services Rendered" 
instead of "Work."  

Bill Sort Order 
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This is the order in which items will appear on your bill. Items are always sorted by date, but you can choose whether they are sorted oldest to newest or newest 
to oldest. By default, TurboLaw® Time and Billing sorts from the oldest item to the newest item. 

Bill Closing Line 

This is the text that will appear at the bottom of bills. You can type whatever you like. 

My Address 

 

Simply type your address as you would like it to appear on bills and statements. 

General 

 

On this tab, you can choose whether you would like the Getting Started screen to be displayed every time you start TurboLaw® Time and Billing, as well as the 
default finance charge rate for new clients. 
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Font 

This is the font that will be used in the headings of printouts. 

Templates 

 

Bill Template 

Click Choose Bill Template to choose the template to be used when creating bills. The name of the template you are currently using is displayed just below the 
button. 

Statement Template 

Click Choose Statement Template to choose the template to be used when creating statements. The name of the template you are currently using is displayed 
just below the button. 

Updates 
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Update Options 

You can choose whether to have TurboLaw® Time and Billing download updates automatically, or not to check for updates at all.  

See also: 

Getting Started screen  
Choose template window  

Stopwatch 
The stopwatch window allows you to keep track of time - just as you would with a real stopwatch. 

 

When you open the stopwatch, this is how it will appear. You can click Start to start the stopwatch. If you need to pause the stopwatch (for example, if you need 
to take a phone call or step away from your desk) just click Pause. If you want to stop the stopwatch and restart from zero, just click Reset. 

When you are done, click Save and TurboLaw® Time and Billing will open the Enter Time window and automatically fill in the time for you. (You must still 
enter the other details, such as the billing category.) 

Opening Multiple Stopwatches 
TurboLaw® Time and Billing allows you to have multiple stopwatches open, so that you can stop work on one client and begin work on another, without having 
to lose track of the time you've accumulated thus far.  

When you open a new stopwatch, TurboLaw® Time and Billing automatically pauses your previous stopwatch, so you don't accidentally double-bill. 

For example, if you receive a phone call from a client while you are busy with a different client's work, you can open a new stopwatch to track the time of the 
phone call. Once you are done with the phone call, you can save that time and then go back to the stopwatch from what you were doing previously and resume 
working. 
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See also: 

Enter time window  
Recording billable time  

Template Designer 
This window allows you to customize every aspect of a template. In the context of the designer, a template is called a report. 

The report designer is virtually a program in its own right - this is only a summary of some of the features of the report designer. For more help, consult the pop-
up tips that appear when you hover your mouse over anything in the designer. 

 

The template designer gives you total control over your templates. You can change sections, layout, fonts, and even perform advanced functions such as 
scripting. 

Tabs 

 

Each tab represents a different group of related buttons. 

Report Designer Tab 
This is the tab you will use most frequently. It contains all of the formatting options for text and appearance.  

Report 
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These buttons let you open, save, and create a new template. 

Edit 

 

These buttons let you perform the standard editing functions, such as cut, copy, and paste - as well as undo and redo. 

Font 

 

These buttons control the appearance of the font of whatever object you have selected. You can choose font type and size, as well as styles such as bold, italics, 
and underline. You can also align text using the standard alignments, as well as change the color of the font, and its background. 

Alignment 

 

These buttons control the way objects are aligned in the template.  

Layout 

 

These buttons control the way groups of objects are laid out relative to one another. 

Zoom 

 

These buttons allow you to zoom in and out on the template. They only affect your view of the template, not how it will be printed. 

View 

 

This button allows you to switch the way you view the template in the designer. 

Print Preview Tab 
This tab is the same as the tab seen in the print preview window. 

HTML View 
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This tab contains buttons for controlling the view of the template as an HTML (web) page. It is for advanced use only. 

Main Template (Report) Section 

 

This is the view of your template (also called a report in the context of the designer).  

A template is made up of several different sections, called bands, which constitute the entire report. In the example shown above, these sections are (from top 
to bottom): 

The Report Header  
The Page Header  
The Report Detail  
The Report Footer  

Some bands are repeated on every page of the report - so if your report is one page long, you will only have one band, but if your report is three pages long, you 
will have 3 bands, one on each page. Other bands only appear once per report.  

For example, the Report Header only appears once per report - you would only want the heading to appear once, even if a bill or template spanned many pages.

Toolbox 
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These buttons along the left-hand side of the designer window represent the different objects you can place in a template.  

Pointer 

Clicking this will return your mouse pointer to normal, allowing you to click on other objects in the template and select them. 

BarCode 

This is a special type of object which represents a postal bar code. It can be used to help the post office route your mail more effectively. 

In most cases, you will not need to use this object. 

Chart 

This is a chart, such as a bar graph or pie chart, that can be placed in your template (if desired).  

In most cases, you will not need to use this object. 

CheckBox 

This is a check box, and can be either checked or unchecked. 

In most cases, you will not need to use this object. 

CrossBandBox 

This is a box that can span multiple sections (bands) of the template (such as the header and the body).  

In most cases, you will not need to use this object. 

CrossBandLine 

This is a line that can span multiple sections (bands) of the template. 

In most cases, you will not need to use this object. 

Label 

This is a simple text label that can be placed anywhere in your template. It is a very commonly used item. 

Line 

This is a simple line. It has two end points, and you can position it any way you like. Other than its appearance, it is purely for decoration. 

PageBreak 

This will insert a page break into the template, which causes a new page to be created when printed.
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In most cases, you will not need to use this object. 

PageInfo 

This is an object to display information about the current page, such as page number, or the title of the document. It is commonly used in the footer of a template.

Panel 

This is an object onto which you can place other objects, so they can be moved and arranged as a single group.  

In most cases, you will not need to use this object. 

PictureBox 

This is an object that lets you put a picture (such as a logo) in your template.  

RichText 

This is an object that lets you place a large amount of formatted text into the template. 

In most cases, you will not need to use this object. 

Shape 

This allows you to place a simple shape in the template. 

In most cases, you will not need to use this object. 

Subreport 

This allows you to make a sub-section to the main report (template).  

In most cases, you will not need to use this object. 

Table 

This allows you to add a table to the template, which you can use to arrange objects or text in a grid-like layout. 

ZipCode 

This is a special form of label that can understand postal zip codes and display them properly. 

In most cases, you will not need to use this object. 

Report Explorer 

 

This section on the right-hand side of the window allows you to navigate among the various parts of the report, including the different sections (bands).  

You can also access the Field List, which is only useful if you are editing a template from the Bill window or the Create Statements window. The field list will 
show you the fields which are used to add data into the template. If needed, you can drag these fields onto the template to cause information to be entered there 
when the final document is created. 

In most cases, it is best to leave the existing fields in the template as provided, and simply move them, rather than try to re-create them using the field list. 

Property Grid 
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This section on the lower right-hand side of the window allows you to edit the various properties of whatever object is currently selected. 

Each object in a template has many different properties - some of which cannot always be edited. Many of these properties (such as font and color) can be 
adjusted more easily by using the toolbar at the top of the screen. 

See also: 

Choose Template window  
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Menus 
There are 4 menus at the top of the main TurboLaw® Time and Billing window. 

File  
View  
Tools  
Help  

See also: 

Tasks  

  

File Menu 
New 
This allows you to create a new database for TurboLaw® Time and Billing. 

Open 
This allows you to open a previously created database for TurboLaw® Time and Billing - including one 
that may be on a network. 

Save As 
This allows you to save the currently open database to a new file - which can have a new name and new 
location on your computer or on your network. Once the database is saved with the new name in the new 
location, it will be opened automatically. 

You can save your database with any name you like, but it cannot have the same name as a database 
which already exists. If you need to replace a database file which already exists, first delete the file from 
outside TurboLaw® Time and Billing, and then use the Save As option to save the file. 

Import 

Import Clients from TurboLaw 

This allows you to import client information from TurboLaw Document Software. If TurboLaw is not 
installed on your machine, or its database cannot be found, you will be asked to locate the TurboLaw 
database manually. 

Import Clients from Outlook 

Page 1 of 4Menus

8/20/2008file://C:\Documents and Settings\Keith\Local Settings\Temp\~hhFA1B.htm



This allows you to import client information from your contacts in Microsoft Outlook. You must have 
Microsoft Outlook installed on your computer in order to use this option. 

Merge data from TurboLaw® Time and Billing 

This allows you to "merge" data from another database created by TurboLaw® Time and Billing. Use 
this option if you have two or more computers that have entered information separately, but that you 
now wish to combine together. 

Export 

Export Clients to CSV 

This allows you to export your clients' information into the CSV (comma-separated values) file format. 
This is a widely used format that most programs can read, so that you can move your clients' data out of 
TurboLaw® Time and Billing if needed. 

Print 
This allows you to print the list that is currently displayed in the main window of TurboLaw® Time and 
Billing.  

Print Preview 
This allows you to preview what the output would look like if you printed the list that is currently 
displayed in the main window of TurboLaw® Time and Billing. 

Page Setup 
This allows you to configure printing options, such as page size, layout, and margins. 

Exit 
This allows you to exit TurboLaw® Time and Billing completely. If you have any unsaved items open, 
you will be prompted to save them before TurboLaw® Time and Billing closes. 

See also: 

Importing from TurboLaw  
Importing from Outlook  
Merging databases  

View Menu 
Home View 
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Workflow 

This switches the home page view to the Workflow view. 

Dashboard 

This switches the home page view to the Dashboard view. 

See also: 

Workflow view  
Dashboard view  

   

Tools Menu 
Billing Categories 
This displays the billing categories list window. 

Staff Titles 
This displays the staff job titles list window. 

Settings 
This displays the settings window, where you can adjust the settings and options for TurboLaw® Time 
and Billing. 

See also: 

Billing Categories list  
Staff Titles list  
Settings  

   

Help Menu 
Contents 
This displays the table of contents for the help file. 

Search 
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This displays the search window for the help file.

Check for Updates 
This checks for updates to TurboLaw® Time and Billing. If an update is available, a notification will be 
displayed to you, and you can choose to install or not install the update. 

Activate Software 
This allows you to activate your copy of TurboLaw® Time and Billing, using your license number.  

About 
This displays information about TurboLaw® Time and Billing, such as the version number and the 
copyright notice. 

See also: 

Activating TurboLaw® Time and Billing  
Updating TurboLaw® Time and Billing  
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List Windows 
List windows in TurboLaw® Time and Billing display a list of items, such as clients, or bills, or 
categories. These windows will appear when you need to be able to add, edit, or delete items from a list. 

Appearance 
All list windows in TurboLaw® Time and Billing have the same appearance. There will be a list on the 
left side of the window, which takes up most of the window space. This is where the items will be listed. 
On the right, there will be 4 buttons: New, Edit, Delete, and Close. 

The Windows 
These are the list windows you will encounter as you use TurboLaw® Time and Billing: 

Categories  
Clients  
Job titles  
Payments  
Staff  
Time and Expenses  
Matters  

See also: 

Billing category window  
Expense category window  
Client window  
Job title window  
Payment window  
Staff window  
Time window  
Expense window  

Categories 
The Categories list window displays all of the billing and expense categories that you can use to classify 
time and expenses in TurboLaw® Time and Billing.
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TurboLaw® Time and Billing uses different categories for work and expenses. 

You can use the New, Edit, and Delete buttons on the right side of the window to create a new category, 
edit the selected category, or delete the selected category (or categories). 

Adding a New Category 
When you click New to add a new category, you must first choose whether it is a billing category or an 
expense category. 
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After making your selection, the appropriate window will be displayed. 

See also: 

Expense category window  
Entering categories  
Billing category window  
What's the difference between a billing category and an expense category?  

Clients 
The Clients list window displays all of your clients whom you have entered into TurboLaw® Time and 
Billing. 
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You can use the New, Edit, and Delete buttons on the right side of the window to add a new client, edit 
the selected client, or delete the selected client(s). 

See also: 

Client window  
Entering clients  

Job Titles 
The job titles list window displays all of the job titles you have entered into TurboLaw® Time and 
Billing. 

 

You can use the New, Edit, and Delete buttons on the right side of the window to add a new job title, 
edit the selected job title, or delete the selected job title(s).
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See also: 

Job title window  

Matters 
The Matters list window displays all matters for a particular client. 

 

You can use the New, Edit, and Delete buttons on the right side of the window to add a new matter, edit 
the selected matter, or delete the selected matter(s). 

See also: 

Enter Matter window  

Payments 
The payments list window displays either all payments received, or just payments received from one 
client. 
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You can use the New, Edit, and Delete buttons on the right side of the window to receive a new 
payment, edit the selected payment, or delete the selected payment(s). 

To view all payments, click Add/Edit Payments from the Workflow home screen.  

To view just payments from one client, open that client and then click Edit Payments.  

See also: 

Receive payment window  
Receiving payments  
Account history  

Staff 
The staff list window displays a list of all staff members who have been entered into TurboLaw® Time 
and Billing, grouped by their job title. 
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You can use the New, Edit, and Delete buttons on the right side of the window to add a new staff 
member, edit the selected staff member, or delete the selected staff member(s). 

See also: 

Staff window  
Entering staff  

Time and Expenses 
The time and expenses list window displays either all the time (work) and expenses you have entered 
into TurboLaw® Time and Billing, or just the time and expenses for one staff member or one client.
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You can use the New, Edit, and Delete buttons on the right side of the window to add a new time or 
expense, edit the selected time or expense, or delete the selected time or expense(s). 

See also: 

Time window  
Expense window  
Recording billable time  
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Getting Started 
TurboLaw® Time and Billing is designed to be very easy to use. The first time you start the program, a Getting Started screen 
will appear to help you.  

This guide is intended as a more in-depth guide. 

Entering Data 
Entering the names of your staff  
Entering categories  
Entering clients  
Recording billable time  
Creating your first bill  
Receiving payments  

The Home Screen 
Workflow view  
Dashboard view  

Navigation 
Using the navigation bar  

Activation and Licensing 
Activating your TurboLaw® Time and Billing License  

See also: 

Getting Started Window  
Home Screen  
Questions  

  

Entering Staff 
In order to use TurboLaw® Time and Billing, you must enter at least one staff member.  

To enter a new staff member, you can: 

Click Enter Staff from the Getting Started window  
Click Add/Edit Staff from the Workflow Home screen  
Click Add Staff from the navigation bar  

However you choose to enter a new staff member, you will end up at the Enter Staff window. Here you can enter the details on 
your staff member; nameley their name, initials, job title, and billing rate. 

Entering Multiple Staff Members 
If you need to enter more than one staff member, simply click Save & New. The current staff member will be saved, and the 
screen will be cleared so you can enter a new staff member. 

See also: 

Enter Staff window  
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Entering Categories 
TurboLaw® Time and Billing includes default categories that you can use or replace as you desire.  

To enter a new category in a screen that lists the categories in a drop-down box, simply type the new name for the category in the 
drop-down box. TurboLaw® Time and Billing will save what you type as a new category automatically. 

Alternatively, you can click Edit this List to display the Categories Window. 

To enter a new category from the Categories Window, simply click Add New. 

See also: 

Billing Category  
Expense Category  
Categories window  

Entering Clients 
Everything in TurboLaw® Time and Billing revolves around clients. When using the program, one of the first things you will do 
is enter your client's information. 

To enter a new client, you can: 

Click Enter Clients from the Getting Started window  
Click Add/Edit Clients from the Workflow Home screen  
Click Add Client from the navigation bar  

However you choose to enter a new client, you will end up at the Client window. Here you can enter the details of your client. You 
must enter at least a name (or company name) before you can save the client. All other information is optional. 

Alternatively, you can import your client's information from another program, such as Microsoft Outlook or TurboLaw. In this 
case, most of the information (such as name, address, and phone number) will be automatically entered for you - assuming that it 
was already entered in the other program. 

Entering Multiple Clients 
If you need to enter more than one client, simply click Save & New. The current client will be saved, and the window will be 
cleared for you to enter a new client.  

See also: 

Client window  
Importing Clients from Outlook  
Importing Clients from TurboLaw  

Recording Billable Time 
When you do work for a client, you can record it in TurboLaw® Time and Billing and then add it to a bill later on. 

To record billable time, you can: 

Click Enter Time/Expense from the Workflow Home screen  
Click Add/Edit Work Items from the Workflow Home screen  
Click Enter New Time/Work from the Client window  
Click Enter Time from the navigation bar (when showing Clients)  

However you choose to enter time, you will end up at the Enter Time window. Here you can enter the details of the time you've 
spent doing work; namely how long it took you and what it was for.
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Entering Multiple Work Items 
If you need to enter more than one work item, simply click Save & New. The current time will be saved, and the screen will be 
cleared so you can enter a new work item. 

See also: 

Enter Time window  

   

Creating Your First Bill 
There are many ways to create a bill. In this example, we will assume that you have already: 

Entered a client  
Entered some time or expenses for that client  

To begin, click Create Bill from the Client Window's activity toolbar. 

 

The Edit Bill window will then open. 

 

The client's name will automatically be selected and any unbilled time or expenses will be automatically displayed.
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Note: This screen shows a simplified view of a bill - it is not a final preview of what the bill will look like when printed.  

At this point, the bill has been created - all that need be done is either to save the bill by clicking Save & Close or print the bill by 
clicking Print. If you want to see what the bill looks like, just click the Print button and then select Print Preview. 

Other Options 
If needed, you can select a different date for the bill. By default, the date displayed will be the date that the bill was created. 

Additionally, you could un-check items from the list of time and expenses. These un-checked items would not be saved as part of 
this bill. 

Void 

If needed, you can void a bill by clicking the Void button. This will set the total for the bill to zero ($0.00), but the bill will not be 
deleted - it will remain in the program and will appear on subsequent statements (although the total will remain at $0.00). In this 
way, you can remove a bill from a client's balance, but still retain an record of it. In general, it is advisable to void a bill rather than 
deleting it, as this preserves an historical record of the work. 

Template 

You can change the template used to create the bill by clicking the Template button. You can select from several included 
templates, or you can choose one of your own. The template you choose will then be used for all subsequent bills you print. 

See also: 

Bill window  
What is the Difference between a Bill and a Statement?  

  

Receiving Payments 
When a client gives you money, you can record this in TurboLaw® Time and Billing by receiving a payment. 

To receive a payment, you can: 

Click Receive Payments from the Workflow Home screen  
Click Receive Payment from the Client window  
Click Receive Payment from the navigation bar (when showing Clients)  

However you choose to receive a payment, you will end up at the Receive Payment window. Here you can enter the details of the 
payment; namely the amount, the date, and the client that gave you the payment. 

Entering Multiple Payments 
If you need to enter more than one payment, simply click Save & New. The current payment will be saved and the screen will be 
cleared so you can enter a new payment. 

See also: 

Enter Payment window  

   

Workflow View 
The Workflow View of the Home Screen is the default view in TurboLaw® Time and Billing. This view allows you to keep the 
most common tasks within easy reach.  
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The Workflow view presents a graphical representation of the most common data-entry "cycle" (the "Billing Cycle") used by 
TurboLaw® Time and Billing; namely, that you enter time (work) and expenses, then create a bill, then create a statement, and 
finally, receive payment from the client. Additional buttons at the bottom of the Workflow view allow you to manage clients, staff, 
and time/expenses that have been entered. You can also show the Getting Started window by clicking Show Getting Started 
Window. 

Because TurboLaw® Time and Billing is so flexible, you can start at any point in the billing cycle - just click whichever action is 
appropriate. 

See also: 

Dashboard View  
The Getting Started Window  

Dashboard View 
As an alternative to the Workflow view, you can choose the Dashboard view to keep a close eye on the figures involved in your 
business. 
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The Dashboard view displays 4 different lists: 

The last 10 payments received  
The last 10 billed items entered  
All of the work (time) that has been entered, but hasn't yet been billed to the client  
All overdue bills  

Each of the 4 lists can be resized, and TurboLaw® Time and Billing will remember your arrangement.  

If you would like to see the details of any item, just double-click on it. TurboLaw® Time and Billing will open the appropriate 
window for that item, allowing you to view the details of that item, as well as edit the item if needed. 

If you want to switch back to Workflow view, you can do so by clicking on Switch to Workflow View.  

See also: 

Workflow view  
The Getting Started Window  

Using the Navigation Bar 
TurboLaw® Time and Billing uses a Navigation Bar located on the left-hand side of the window to switch between different 
sections of the program. Using this bar, you can quickly switch between the main screens of TurboLaw® Time and Billing.
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Each item on the navigation bar works like a "link" in your web browser - it only takes one click to activate.  

Each section of the navigation bar can be "collapsed," so that its items are not visible. This can be handy if you don't use a certain 
section very much and want to free some space on your screen. Simply click the "collapse" button (which looks like an upward 
pointing arrow, e.g., ^) to collapse the section. To restore a section, click the collapse button again (it will look like a downward 
pointing arrow). 

If the navigation bar is too narrow to read, you can use your mouse to resize the navigation bar. Simply grab its right edge with 
your mouse pointer (click and hold down the left mouse button) and drag it left or right.  

The Main Navigation Bar 
Pictured below is the main portion of the navigation bar. This section is always visible, no matter what screen you are looking at. 
It contains all of the basic navigation links for TurboLaw® Time and Billing. 

 

Navigation Toolbar 

While not strictly part of the navigation bar itself, the Navigation Toolbar contains two helpful buttons for navigating 
TurboLaw® Time and Billing. 

Back 

The Back button allows you to go back to the previous screen. It functions very much like the "back" button in most web 
browsers. If you need to go back to a previous screen, this button is always available. 

Home Button 

Next to the back button is the Home button. Clicking this button will immediately return you to the Home screen of TurboLaw® 
Time and Billing. 

Navigation Bar 

The main navigation bar section contains a number of navigation links, each of which will either show a new screen to the right, 
or open a new window (depending on the function). 

Home 

This link functions just like the home button. Clicking this link will immediately return you to the Home screen of TurboLaw® 
Time and Billing. 

Clients 

Clicking this link will display the list of clients in the main window, as well as the client-specific secondary navigation bar.
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Bills 

Clicking this link will display the list of bills in the main window, as well as the bill-specific secondary navigation bar. 

Staff 

Clicking this link will display the list of staff members in the main window, as well as the staff-specific secondary navigation bar. 

Graphs (formerly "Reports") 

The Graphs link (formerly called "Reports") will open the graphs window. From here you can select the type of graph (or chart) 
you wish to view or print. 

Statements 

Clicking this link will open the Statements window. 

Stopwatch 

Clicking this link will open a stopwatch. You can click this link again to open additional stopwatches, if needed. 

Secondary Navigation Bars 
The secondary navigation bars appear based upon what is displayed in the main list of TurboLaw® Time and Billing. 

Clients Bars 

 

The client-specific navigation bars allow you to add a new client, edit the selected client, or delete the selected client(s), as well as 
change which clients are displayed (either Active, Inactive, or All Clients). 

The Other Tasks bar is collapsed by default; to expand it, simply click the downward-pointing arrow. This will display additional 
links that allow you to perform additional tasks for the selected client. 

Bills Bars 
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The bill-specific navigation bars allow you to create a new bill, edit the selected bill, or delete the selected bill(s), as well as 
change which bills are displayed and how they are grouped together. 

Staff Bar 

 

The staff-specific navigation bar allows you to add a new staff member, edit the selected staff member, or delete the selected staff 
member(s), as well as view the work (and expenses) logged by the selected staff member (or all staff members, if nothing is 
selected). 

See also: 

Getting Started window  
Workflow Home Screen  
The Main window  
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Entry Windows 
In this context, Entry Windows are windows where you enter information about something, such as a client, a category name, or 
work that you've done. These windows are also used to edit these items. 

Billing category  
Client  
Expense category  
Expense  
Job title  
Payment  
Staff member  
Time/Work  
Matter  

Enter Billing Category 
This window allows you to enter a new billing category. Billing categories are used to categorize the work that you do for your 
clients, whether you bill by the hour, use a flat-fee type billing system or a combination of both. They are distinct from expense 
categories, which are used to categorize expenses that you pass on to your clients. 

 

To enter a billing category, simply type the name as you would like it to appear and then click Save. If you do not want to create a 
category, click Cancel. 

See also: 

Enter expense category  
Enter time/work  
Categories window  

Enter Client 
This window allows you to enter the details of one of your clients. 
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Although TurboLaw® Time and Billing can save many different types of information regarding your client, at a minimum you 
must enter a name (either personal or company) before you can save a client. 

Sections 
The enter client window consists of several different sections. 

Name 

You can enter the first, middle, and last name of your client. You can also enter the name of the company your client works for, or 
just the name of the company if the company itself is your client. 

Note: In order to save a client, you must fill in at least one name field. 

Address 

You can enter the address of your client here. Type the address as you would like it to appear on bills and statements. If you are 
going to use the address printed on bills and statements as the delivery address for sending bills and statements through the mail, 
make sure the addresses you enter meet your postal system's requirements. 

Phone and Email 

TurboLaw® Time and Billing allows you to enter up to 3 phone numbers for each client. Although they are labeled as Home, 
Work, and Cell (or Other), you can enter whatever number you need. (For example, you could instead type a client's fax number in 
the work field). 

You can also enter your client's email address. TurboLaw® Time and Billing only allows you to save one email address per client. 

These fields are for your own reference only; TurboLaw® Time and Billing does not use the information you enter in any way. 

Customer ID 

If you already have an ID number for your customer, or if you want to use your own customer / client ID scheme, you can type 
whatever ID number you like in this field. 
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TurboLaw® Time and Billing will still assign a unique ID number to your client, regardless of whether you enter your own 
customer ID or not. However, if you enter your own customer ID number, TurboLaw® Time and Billing will display that number 
instead. You can also search for clients using your own customer ID number, or TurboLaw® Time and Billing's ID number. 

If you are entering your own customer ID you do not have to use numbers exclusively; you can include letters and other symbols if 
desired. 

Finance Charges 

If you wish, you can assign a finance charge rate to your client, along with terms that dictate how long after a bill is generated it 
becomes "overdue" and finance charges begin to apply. 

You can change the default values that TurboLaw® Time and Billing uses for new clients in the Settings window. 

Finance charges are calculated monthly. 

Account Status 

You can see the status of your client's account here. The outstanding balance, along with any time you've entered but have not yet 
billed for, is shown here. You cannot directly edit these values; they are for display purposes only. 

Notes 

You can enter whatever notes you wish in this box.  

Toolbars 
Because a client is the centerpoint of activity in TurboLaw® Time and Billing, you can access almost every function from the 
client window. Unlike other windows in TurboLaw® Time and Billing, the client window has two toolbars - a main toolbar and an 
activity toolbar. 

 

The main toolbar contains the standard Save, Print, Delete, Previous, and Next buttons. 

Activity Toolbar 

The activity toolbar contains all the "activities" you are likely to need when working with a client. 

Time/Work 

Clicking the Time/Work button will drop down a menu, where you can select Enter Time to make a new time entry, or Edit 
Time/Work, where you can see the list of time/work that has been performed for this client and edit any entries you wish. 

Expenses 

Clicking the Expenses button will drop down a menu, where you can select Enter Expense to make a new expense entry, or Edit 
Expenses, where you can see the list of expenses that have been entered for this client and edit any entries you wish. 

Payments 

Clicking the Payments button will drop down a menu where you can select Enter Payment to enter a new payment, or Edit 
Payments, where you can see the list of payments that have been entered for this client and edit any entries you wish. 

Matters 

Clicking the Matters button will drop down a menu where you can select New Matter to enter a new matter, or Edit Matters, where
you can see the list of matters that have been entered for this client and edit any entries you wish.
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Stopwatch 

Clicking the Stopwatch button will open the Stopwatch window. 

Account History 

Clicking the Account History button will open the Account History window, which allows you to see the history of bills, 
statements, and payments for this client. 

Create Bill 

Clicking the Create Bill button will open the Create Bill window and create a new bill for this client. 

Create Statement 

Clicking the Create Statement button will open the Create Statements window. 

Import 

This drop-down button allows you to import just one client from either TurboLaw or Microsoft Outlook.  

See also: 

Entering Clients  

Enter Expense Category 
This window allows you to enter a new expense category. Expense categories are used to categorize expenses that you've incurred 
on behalf of your clients. They are distinct from billing categories, which are used to categorize work that you've done for your 
clients whom you bill. 

 

To enter an expense category, simply type the name as you would like it to appear and then click Save. If you do not want to 
create a category, click Cancel. 

See also: 

Enter billing category  
Enter time/work  
Categories window  

Enter Expense 
This window allows you to enter a new Expense that you've incurred on behalf of your client. Typically, you will charge your 
client for this expense, although you have the option to mark the expense as not billable if you desire. 
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Sections 
The Enter Expense window is divided into several sections. 

How much was the expense? 

You can enter the amount of the expense here.  

What was it for? 

This is the expense category. You can choose one that you have already entered, or click Edit this List to create a new category.  

Additionally, you can check This expense was not billable if you want the expense to appear on your client's bill, but not to 
charge your client for it.  

Which client are you billing this expense to? 

You can select from any of the clients you have previously entered. 

Matter (Optional) 

If you want to bill this expense to a particular matter you have entered for this client, you can choose that matter in this section. If 
you need to add, edit, or delete matters for this client, click Edit this List. 

If you change your mind and do not want to associate this expense with a matter, click the "X" button to clear your selection, and 
the expense will not be filed under any particular matter. 

The drop-down box for selecting a matter is only available after you have first selected a client. 

Date Expense Incurred 

You can enter the date you incurred this expense. 
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Staff Member (if any) 

Some expenses are tied to a particular member of your staff (for example, travel expenses). If this applies to your particular 
expense, you can select the applicable staff member from this list, or click Edit this List to enter a new staff member. You do not 
have to fill out this field if you don't want to.  

Notes 

Any additional notes regarding this expense can be entered here. Your notes will appear on the printed bill exactly as you enter 
them here. 

See also: 

Enter Time window  
Time and Expenses window  

Enter Job Title 
This window allows you to enter the job title of a member of your staff. These titles are just descriptive; they do not have to 
correspond to any "real" job titles. If you have a large staff, they can be helpful for organizing staff members in groups. 

 

The job title you enter will not appear on any bills or invoices; it is only used for descriptive purposes in TurboLaw® Time and 
Billing itself. 

See also: 

Job titles window  
Enter staff window  

Enter Matter 
The Enter Matter window allows you to enter a new Matter as well as associate Time/Work items, Expense Items, and Bills 
with the matter. 

  

Aside from the client for the matter (which is selected automatically when you create a new matter, based on the client you were 
editing), you can give the matter a name or description and mark the matter as being open or closed. 
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Activity Toolbar 
Like the Enter Client window, the Enter Matter window has an activity toolbar. It allows you to work with items that can be 
associated within a matter. These buttons work exactly like the corresponding buttons on the Enter Client activity toolbar. 

See also: 

Matters list  
Enter Client window  

  

Enter Payment 
This window allows you to enter the details of a payment you've received from a client. 

 

Payment Details 
In this section, you can select the client that this payment is for, or click Edit this List to add a new client. 

You can also enter the amount of money that was received and the date on which you received it. 

Notes for the payment are entirely up to you - you can enter check numbers, credit card confirmation numbers, or receipt numbers.

Open Bills 
This section lists all of the open bills for the selected client. If a client has paid a bill in full, check the box next to the bill to 
indicate that it is now PAID. 

Unpaid Balance 
This section shows what the client's unpaid balance is right now. It does not include the payment you are entering.
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See also: 

Payments  
Receiving Payments  

Enter Staff 
This window allows you to enter the names and billing rates of your staff. 

 

Name and Title 
In this section, you can enter the name, initials, and title for this staff member. 

Initials 

As you type in the staff member's name, the initials will be entered for you. If you want to change the auto-generated initials, 
simply type in the box. 

Title 

You can either select an existing title from this drop-down list or type in a new title. You can also click Edit this List to edit the 
list of available titles. 

Billing Rate 
This is the rate at which this staff member bills clients.  

See also: 

Enter Job Title  
Entering Staff  
Job Titles  

Enter Time 
This window allows you to enter the amount of time that you have worked for a client. (You can also enter flat-rate and non-
billable items as well.) 
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Sections 

Time 

In this section you can type in the amount of time you spent (in hours) doing the work (if applicable). For example, if you spent 15 
minutes, you would type in 0.25 (one quarter of an hour). If you have set your billing interval, TurboLaw® Time and Billing will 
round your entry to the nearest interval, based on your settings. 

You can also click Use Stopwatch to open the stopwatch, which you can use to track your time with. 

What was this time for? 

In this section, you can categorize the work you have done. TurboLaw® Time and Billing provides built-in categories or you can 
add your own. If you need to edit the items in this drop-down list, click Edit this List. If you want to add a new item to the list, 
just type it into the box. 

You can also select whether the time was not billable. Selecting this option will cause TurboLaw® Time and Billing to change the 
Amount to be Billed to zero ($0.00).  

You can also select whether this was a flat fee item. Selecting this option will allow you to type directly in the Amount to be 
Billed box, instead of having the program calculate this amount for you. 

Who performed this work? 

In this section, you can choose the staff member who performed the work. The staff member you choose determines the billing 
rate that will be applied. If you would like to add, edit, or remove a staff member from the list, click Edit this List. 

Billing Rate 

This is the billing rate for the staff member you have selected. It appears after you have selected a staff member. If necessary, you 
can override the default billing rate for that staff member - for example, if you have an arrangement to bill at a different rate for 
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one particular client, or if you want to offer a discount. 

If you change the billing rate in this box, it is applied to this item only - the next time you enter time and select a staff member, the 
default billing rate will be used. 

Which client were you performing this work for? 

In this section, you can choose the client for whom you were performing the work. If you need to add, edit, or delete clients from 
the list, click Edit this List. 

Matter (Optional) 

If you want to bill this time to a particular matter you have entered for this client, you can choose that matter in this section. If you 
need to add, edit, or delete matters for this client, click Edit this List. 

If you change your mind and do not want to associate this time with a matter, click the "X" button to clear your selection, and the 
time will not be filed under any particular matter. 

The drop-down box for selecting a matter is only available after you have first selected a client. 

Tax 

In this section, you can choose whether tax applies to this item. You can specify the tax rate as a percentage - simply type the 
percentage into the box and TurboLaw® Time and Billing will calculate the tax automatically. 

Details 

In this section, you can type any additionial details or description about this item. Whatever you type here will be displayed on the 
bill. 

Date Services Performed 

In this section, you can select the date that the work was performed. This date will appear on the bill. 

Amount to be Billed 

This is the amount that will be billed. Normally TurboLaw® Time and Billing will calculate this amount automatically. However, 
if you have specified that this is a flat fee item, you will be able to type an amount here. Clicking the drop-down box will display a
small calculator window which you can use to calculate an amount, if needed. 

See also: 

Enter Expense window  
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Questions 
These are some common questions that may come up while using TurboLaw® Time and Billing. 

What is the difference between a Time or Expense code?  
What is the difference between a Time or Expense entry?  
What is the difference between a bill and a statement?  
What is the Customer Experience Improvement Program?  

What is the Difference Between a Time Entry 
and an Expense Entry? 
A time entry is work that you've done for a client for which you are billing that client. In many cases 
you will record the time you spent doing the work, but you could also enter it as a flat fee item. 

An expense entry is an expense you've incurred that you will pass on to your client. Expense entries 
don't have a time component - they are just the dollar amount of the expense. 

See also: 

Enter Time window  
Recording billable time  
Enter Expense window  

What is the Difference Between a Time Code and 
an Expense Code? 
A time code is a category for time entries. An Expense code is a category for an expense. 

TurboLaw® Time and Billing keeps separate categories for each item, so that you don't end up with a 
huge category list. 

See also: 

Time category  
Expense category  

What is the difference between a bill and a 
statement? 
In TurboLaw Time and Billing, a bill (also sometimes called an invoice) is just what you'd think it is: an 
itemized list of work done for (or expenses incurred on behalf of) the client, and how much is owed to 
you for it. For example, a bill might have the following items on it:

Page 1 of 3Questions

8/20/2008file://C:\Documents and Settings\Keith\Local Settings\Temp\~hhE2B6.htm



Spent 3 hours in court: $750.00  
Travel expenses to meet with client: $75.00  
On-site meeting: $250.00  
TOTAL DUE: $1,075.00  

This is like a bill or invoice that you might get when you purchase something. TurboLaw Time and 
Billing calls it a "bill" because you "bill" for your services, while you get an "invoice" for goods – but in 
practice the two terms are generally interchangeable. 

A bill doesn’t say anything about money that might have already been paid – it simply lists the work or 
expenses you've done or incurred and how much they total. 

On the other hand, a statement in TurboLaw Time and Billing is a "statement" of the status of the 
client's account at a particular point in time. Each line item on a statement represents either a bill or a 
payment. As such, it doesn't offer as much detail as a bill; but it does show payments made toward the 
account. Statements are often sent out on a regular basis (e.g., monthly – like your credit card statement) 
to show your clients where they stand (and if they still owe you money). For example, a statement might 
have the following items on it: 

Balance forward: $85.67  
Bill #123: $290.00  
Payment #82: $50.00  
TOTAL BALANCE: $325.67  

This shows that the client had a balance due of $85.67 from before the period of this statement (if you 
send out statements monthly, your statement period is usually "the last 30 days") and that in that time, a 
bill for $290.00 was produced, but the client sent in a payment of $50.00, resulting in a final balance due 
of $325.67. 

In general, you'd use a bill to show the details of the work and expenses for which you are billing. You'd 
use a statement to give an overall indication of the client's account, including any 
payments/retainers/etc. You don't have to limit yourself to sending statements only at the end of the 
month – if you want to give your clients frequent overviews of their accounts you can print a bill and a 
statement for a client and send them out together.  

Ultimately, how you use bills and statements is up to you – use them in whatever way works best for the 
way you do business and to enhance cash flow. 

See also: 

Bill Window  
Statments Window  

   

What is the Customer Experience Improvement 
Program? 
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The Customer Experience Improvement Program is an optional program where anonymous information 
on how you use TurboLaw® Time and Billing is collected and transmitted to us periodically, without 
interrupting you. This information helps us identify which features to improve. 

Other Questions 

How does the program work? Will I have to answer questions? Will I be interrupted? 

The program silently records statistical information on what options, features, and buttons you press 
most often in the program. It then sends this anonymous statistical data back to our servers and then 
clears the data that was sent to us from your computer. 

It will never interrupt you or ask you any questions after you make your initial choice to either enroll or 
not enroll in the program. 

Will I be contacted? 

No. You will never be contacted because of or in relation to this program. 

What data is being collected? 

Only anonymous, statistical information on how you use the program is collected - what buttons you 
press most often, for example. A timestamp is also included so that we can chart usage over time, as is a 
random, unique number that is used simply to identify the data in our database. 

How is the program "anonymous?" How is my privacy assured? 

We take our customers' privacy very seriously. No personally-identifiable information about you, 
your computer, your license, or your software is ever transmitted. The program generates random, 
unique numbers to identify the data for our database, but these numbers cannot be traced back to you or 
your computer. 

Is any of my client data transmitted? 

No - your client data is never transmitted.  

What if I change my mind? 

The Updates tab of the Settings window allows you to change your enrollment in the program. 

What is the purpose of the program? 

The purpose of the Customer Experience Improvement Program is to allow us to see exactly how people 
are using the program - what buttons they click on most often, which features they use frequently, etc. A 
statistical analysis of this data is very helpful in identifying which features to improve, based on which 
features people use most often. 
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